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Tutorial Session: Tutorial Session: EXPOEXPO software software
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Main FunctionsMain Functions

Indexing

Space group determination

Estimation of integrated intensities

Structure solution by direct methods

Structure model optimization

Real space techniques

Rietveld refinement

Crystal structure visualization 
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Registration and downloadRegistration and download

http://www.ba.ic.cnr.it/softwareic/expo/expo2014-download/

Free download of software and documentation fromFree download of software and documentation from

http://www.ba.ic.cnr.it/softwareic/expo/expo2014-download/
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Supporting materialsSupporting materials

http://www.ba.ic.cnr.it/softwareic/expo/tutorials-and-lectures/

Presentation slides

Examples

http://www.ba.ic.cnr.it/softwareic/expo/tutorials-and-lectures/


  

A
IC

S
2

0
1

8
 –

 P
o

w
d

e
r 

D
iff

ra
ct

io
n

: T
h

e
o

ry
, S

o
ft

w
a

re
 a

n
d

 A
p

p
lic

a
tio

n
s.

 B
a

ri,
 2

9
 A

u
g

 –
 0

2
 S

e
p

Technical detailsTechnical details

Program written in Fortran and C++

Program is built using 
OpenGL and GTK libraries

Licensed under terms of a Licence Agreement

http://www.ba.ic.cnr.it/softwareic/expo/tutorials-and-lectures/

http://www.ba.ic.cnr.it/softwareic/expo/tutorials-and-lectures/
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WindowsWindows 32-bit or 64-bit: Windows 7/8/10, Vista, XP
File   *.exe

OS XOS X: macOS 10.12 (Sierra), OS X 10.11 (El Capitain), 
OS X 10.10 (Yosemite), Mac OS X 10.9 (Mavericks)
File *.dmg

GNU/LinuxGNU/Linux: Ubuntu 16.04 LTS, Ubuntu 14.04 LTS, 
Fedora 24, Centos 7
File *.deb, *.rpm, *.tar.gz

System requirementsSystem requirements

http://www.ba.ic.cnr.it/softwareic/expo/tutorials-and-lectures/

http://www.ba.ic.cnr.it/softwareic/expo/tutorials-and-lectures/
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Crystal Structure Determination ProcessCrystal Structure Determination Process

Indexing & 
space group 
determination

Structure solution

Rietveld method

unit cell & space group

initial structural model

final crystal structure

Experimental powder diffraction 
pattern the biggest challenge

http://www.ba.ic.cnr.it/softwareic/expo/tutorials-and-lectures/

http://www.ba.ic.cnr.it/softwareic/expo/tutorials-and-lectures/
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The indexing equationThe indexing equation

Bragg's equation

dhkl=f (h, k ,l , a , b , c ,α ,β , γ)

a=
b*

∧c*

V * b=
c*

∧a*

V * c=
a*

∧b*

V *
V *=a*⋅b*∧ c*=

1
V

d hkl
*

=ha*
+k b*

+l c*

dhkl
* =

1
dhkl

Peak search θhkl
obs dhkl

obs=λ
2

sinθhkl
obs

dhkl
obs≃f (h, k ,l , a , b , c ,α ,β , γ)



  

A
IC

S
2

0
1

8
 –

 P
o

w
d

e
r 

D
iff

ra
ct

io
n

: T
h

e
o

ry
, S

o
ft

w
a

re
 a

n
d

 A
p

p
lic

a
tio

n
s.

 B
a

ri,
 2

9
 A

u
g

 –
 0

2
 S

e
p

Peak searchPeak search

Peak search is needed in order to locate the peak positions

The method is a combinations of:

background subtraction

Kα2 stripping

smoothing

calculation of the derivatives

25 first peaks can generally solve the indexing problem. Uncertain and 
not cleary resolved peaks should be not included. Try different selection 
of experimental peaks.
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Peak searchPeak search

Graphical tools are provided to improve the peak search
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Indexing by N-TREOR09Indexing by N-TREOR09

Maximum volume and cell dimensions

Maximum number of impurity lines

Minimum figure of merit

Output files: condens.out, ntreor.out
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DICVOLDICVOL

DICVOL is an exhaustive trial-and-error indexing program with variation of parameters
 by successive dichotomy and partitioning of the unit cell volume. 

GUI may also be used to set maximum lengths of
 the unit cell edges, monoclinic angle and unit cell
 volume.

Error in peak positions can be supplied and is
assumed identical for every observed peak.

Maximum number of unindexed Bragg peaks

Any crystal system can be included or excluded 
from the indexing process

It is possible to increase a minimum figure of 
merit, M

20
 (the default is 10)

Estimate and correct for the presence of 
zero-shift error

Measured density and formula weight
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McMailleMcMaille

The recommendation would be to start with TREOR or DICVOL, and finally McMaille 
if no convincing result is obtained. 

Treor and Dicvol run much faster than McMaille. 
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Run Expo2014 for indexingRun Expo2014 for indexing

by graphic interface 
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via an ASCII input file (*.exp) requiring minimal information and consisting of: 

%structure dfqp
%job decafluoroquarterphenyl (C24 H8 F10)
%data

pattern dfqp.dat
wave 1.790000
range 7.000  70.000

%ntreor
%continue

 commands (the first character in the line must be ‘%’)

 directives (sub-commands following the related command)

Run Expo2014 for indexingRun Expo2014 for indexing
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Indexing of Indexing of decafluoroquarterphenyl decafluoroquarterphenyl 

C
24

H
8
F

10

decafluoroquarterphenyl

%structure dfqp
%job decafluoroquarterphenyl
%data

pattern dfqp.dat
wave 1.790000

%ntreor
%dicvol

*L’. Smrčok, I , B. Koppelhuber-Bitschnau, K. Shankland, W. I. F. David, D. Tunega I and R. Resel. Z. Kristallogr. 216 (2001) 63–66.
https://doi.org/10.1524/zkri.216.1.63.18991

Published cell*

a: 24.0519
b: 6.1529
c: 12.4207
β: 102.755

https://doi.org/10.1524/zkri.216.1.63.18991
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Indexing of Indexing of diltiazem hydrochloridediltiazem hydrochloride

C
22

H
27

N
2
O

4
S·Cl

Published cell*  

a: 42.190 
b: 9.075
c: 6.037 

Default maximum cell 
axis value = 35 Å

Diltiazem hydrochloride

Change default settings by GUI
or adding the directive CEM in 
the input file

%structure diltia
%job diltiazem 
%data
pattern pd_0029.pow
wave 1.540560
%ntreor
CEM=50,

*Kojic Prodic, B., Ruzic Toros, Z., Sunjic, V., Decorte, E. & Moimas, F. (1984). Helv. Chim. Acta, 67, 916–925.
https://doi.org/10.1002/hlca.19840670333

https://doi.org/10.1002/hlca.19840670333
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Two unindexed lines from small 
amount of the hexagonal phase

C
10

H
10

norbornene

Published cell*  

a: 7.6063 
b: 8.6220 
c: 8.749  
β: 97.24

*M. Brunelli et al. “Crystal and Molecular Structures of Norbornene.” Zeitschrift für Kristallographie, 2001 : 51–55.
https://doi.org/10.1524/zkri.216.1.51.18996

Indexing of norborneneIndexing of norbornene

https://doi.org/10.1524/zkri.216.1.51.18996
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The solution is not always straightforward because of several reasons:

Inaccuracy in peak positions due  to:

The presence of impurities providing spurious additional peaks

Errors in powder indexingErrors in powder indexing

1.zero-point error
2.sample misplacement
3.low resolution
4.bad crystallinity

Data quality remains the most important factor in indexing
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Do not waste computer time on bad data 

Some adviceSome advice

Do not accept unindexed peaks, unless you are able to explain them

To obtain a proper solution, it is necessary to eliminate the impurity Bragg 
peaks from the indexing process

Every observed peak must correspond to a calculated reflection 

Finally, in the case of a new material, the correctness of the ab initio indexing is 
generally ensured by solving and refining the crystal structure
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Analysis of the systematically 
absent reflections Extinction symbol (ES)

The ES does not unambiguously define the space group

Cryst. 
system

Ext. symb Space groups

Mon. P1 - 1 P2, Pm, P2/m

Mon. P1 2
1 
1 P2

1
, P2

1
/m

Mon. P1 2
1
/c 1 P2

1
/c

Orth. P- - - P222, Pm2m, P2mm, Pmm2, Pmmm

Tetr. P- - - P4, P4, P4/m, P422, P4mm, P42m, P4m2, 
P42

1
m, P4/mmm

Space group determinationSpace group determination
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The Expo procedure for space group determinationThe Expo procedure for space group determination

This may be synthesized into the following steps:

1.The experimental powder diffraction diagram is decomposed via the Le Bail algorithm
into single diffraction intensities in the space group having the largest Laue symmetry 
and no extinction conditions (e.g., P2/m for monoclinic, P2/m2/m2/m for orthorhombic,
P4/mmm for tetragonal, P6/mmm for trigonal-hexagonal systems, and Pm3m for the
cubic system).

2.The normalized intensities z
h
 = |E

h
|2 are submitted to statistical analysis for the 

determination of the space group symmetry.

3.The algorithm provides a probability value for each extinction symbol compatible with
the lattice symmetry established by the indexing procedure.
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Indexing and space group determination of paracetamolIndexing and space group determination of paracetamol

Paracetamol (form I polymorph) 
C

8
H

9
NO

2
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Cell content = Z · molecular formula

Cell contentCell content

Z=
Vcell

Vmol

Z=
Vcell

18⋅M

V
mol

 = volume of molecule  

18 Å3 rule: V
mol

 = M · 18   

M =  number of non-hydrogen atoms 
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Vmol=∑ ni vi

n
i
 = number of atoms of the ith type in the structure

v
i
 = volume contribution (in Å3) for the ith atom type

v
H
 = 5 Å3

v
C
 = 14 Å3      

v
N
 = 12 Å3

Some approximate atomic volumes:

Acccurate estimation of molecular volumeAcccurate estimation of molecular volume

v
O
 = 11 Å3   

v
S
 = 25 Å3

v
F
 = 11 Å3

Complete list of average volume of the atoms in appendix A: 
http://www.ba.ic.cnr.it/softwareic/expo/average-volume-of-the-atoms/
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Volume of unit cell = V
cell

= 773 Å3  

Cell content of paracetamolCell content of paracetamol

18 Å3 rule 

Z=
Vcell

18⋅M
=

773
18⋅11

=3.90∼4

Accurate method 

Vmol=∑ ni v i=8 vc+9 vH+vN+2 vO=8⋅14+9⋅5+12+2⋅11=191 Å3

Z=
Vcell

Vmol

=
773
191

=4.05

Chemical formula: C
8
H

9
NO

2

Cell content: Cell content: (C8H9NO2)4   or   C32H36N4O8

http://www.ba.ic.cnr.it/softwareic/expo/average-volume-of-the-atoms/
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Volume of unit cell = V
cell

= 1799 Å3  

Cell content of decafluoroquarterphenylCell content of decafluoroquarterphenyl

18 Å3 rule 

Z=
Vcell

18⋅M
=

1799
18⋅34

=2.90∼2

Accurate method 

Vmol=∑ ni v i=24vc+8 vH+10vF=24⋅14+8⋅5+10⋅11=486 Å3

Z=
Vcell

Vmol

=
1799
486

=3.70∼4

Chemical formula: C
24

H
8
F

10

Cell content: Cell content: (C24H8F10)4   or   C96H32F40

or 4
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Space group determination of paracetamolSpace group determination of paracetamol
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Space group determination of paracetamolSpace group determination of paracetamol
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Space group determination of decafluoroquarterphenylSpace group determination of decafluoroquarterphenyl

%structure dfqp
%job decafluoroquarterphenyl (C24 H8 F 10)
%data
pattern dfqp.dat
wave 1.790000
cont (C24 H8 F10)4
cell  24.085501  6.155077  12.435071  90.00000  102.68274  90.00000
%continue
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Methods of Structure SolutionMethods of Structure Solution

Structure
 solution

Traditional approaches:

direct methods
Patterson methods

Direct space methods

Alternative words:real space, 
global optimization, global search

Other methods:

charge flipping
molecular replacement
…...............................

W. I. F. David and K. Shankland. Structure determination from powder diffraction data. Acta Cryst. A64, 52 (2008)
https://doi.org/10.1107/S0108767307064252
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Random phases
 assignement

New phase set (trial) and FOM

N
max

 trial?

Scaling and normalization of 
the structure factors F

h
 → E

h

A Typical Direct Methods ProcedureA Typical Direct Methods Procedure

Triplet and negative quartet 
invariants are found among the 
reflections with largest E

h

Cycles of tangent formula

No

https://doi.org/10.1107/S0108767307064252
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Select the 
most  
reliable 
trial

Suitable 
model?

Select a new trial

No

Rietveld
Yes

E-map 
calculation
and 
preliminary 
refinement

Tangent procedure

A Typical Direct Methods  ProcedureA Typical Direct Methods  Procedure

Scaling and normalization of 
the structure factors F

h
 → E

h

Triplet and negative quartet 
invariants are found among the 
reflections with largest E

h
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Completion of the Crystal StructureCompletion of the Crystal Structure
and Preliminary Refinementand Preliminary Refinement

Observed Fourier *

Structure factor calculation

Structure factor calculation

Least-squares refinement

Partial structure 

E-map
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Resolution Bias Correction Algorithm (RBM)Resolution Bias Correction Algorithm (RBM)

Electron density of a crystal structure

Calculated electron-density map

Features of 

Negative in more or less extended regions

Atomic peaks show deformed profile and are surrounded by 
series of negative and positive ripples

Atomic peak are shifted from the correct position

RBM

Altomare, A., Cuocci, C., Giacovazzo, C., Kamel, G.S., Moliterni, A. & Rizzi, R. (2008): Minimally resolution biased 
electron-density maps. Acta Cryst. A64: 326–336.
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Least-squares refinement

Partial structure 

Fourier map

RBM

Default Strategy of Model Optimization in the EXPO ProgramDefault Strategy of Model Optimization in the EXPO Program

http://journals.iucr.org/a/issues/2008/02/00/sh5067/index.html
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Crystal structure determination of Cimetidine compoundCrystal structure determination of Cimetidine compound**

Required information:

Chemical formula: C
10

H
16

N
6
S

4

Powder diffraction data file
cime.dat

wavelength 1.52904
synchrotron

cimetidine
C

10
H

16
N

6
S

**R. J. Cernik, A. K. Cheetham, C. K. Prout, D. J. Watkin, A. P. Wilkinson and B. T. M. Willis. J. Appl. Cryst. (1991). 24, 222-226
https://doi.org/10.1107/S0021889890013486
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Crystal structure solution Crystal structure solution of of P(CP(C
66HH66))33  

%structure pph3
%job triphenylphosphine
%data

pattern pph3.xy
wave 1.000972
syncrothron
range ­1 60
space P 21/c
cell  8.495202  15.028483  11.430653  90.0  92.89145  90.0
content (P(C6H5)3)4

%continue

https://doi.org/10.1107/S0021889890013486
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Crystal structure determination of famotidineCrystal structure determination of famotidine**

%job famotidine (C8 H15 N7 O2 S3)
%structure famo
%init
%data

pattern famo.xy
wave 0.8507473
cell     17.6547 5.29320 18.2590 90.0 123.5580 90.0
space p 21/c
cont (C8 H15 N7 O2 S3)4
synchrotron

%continue

*K. Shankland, L. McBride, W. I. F. David, N. Shankland and G. Steele. J. Appl. Cryst. (2002). 35, 443±454. https://doi.org/10.1107/S0021889802007835
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Crystal structure determination of BaMoCrystal structure determination of BaMo33OO1010
**

*Werner, P.-E., Moustiakimov, M., Marinder, B.-O. & Knight, K. S. (1997). Z. Kristallogr. 212, 665–670. https://doi.org/10.1524/zkri.1997.212.9.665

Space group: P21; Z = 4

a = 14.695(2) Å, b = 7.5704(7) Å, c = 6.9618(6) Å, and β = 100.381(8)°

https://doi.org/10.1107/S0021889802007835
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When default Expo2014 fails: strategiesWhen default Expo2014 fails: strategies

Explore trials

Apply the RAMM (Random based Method)

Structure model optimization

https://doi.org/10.1524/zkri.1997.212.9.665
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Crystal structure solution of the 2-mercaptobenzoic acidCrystal structure solution of the 2-mercaptobenzoic acid**

%Structure merca
%Job 2­Mercaptobenzoic acid (C7 H6 O2 S)
%Data

Pattern    merca.xy
Wavelength 1.54056
Cell       7.885  5.976   14.949  90.0  100.48  90
SpaceGroup p 21/c
Content   (C7 H6 O2 S)4

%continue

*Steiner, T. Acta Cryst. (2000). C56, 876±877. https://doi.org/10.1107/S0108270100005898
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*Ávila, E. E. (2009). Acta Cryst. B65, 639–646

Crystal structure solution of a bidentate pro-ligand,
C

21
H

34
N

2
S

2
 from powder synchrotron diffraction data*

All trials were explored during
the Direct Methods procedure

https://doi.org/10.1107/S0108270100005898
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pCommand Command %alltrials%alltrials

%structure dispiro
%job bidentate pro­ligand C21 H34 N2 S2
%data

pattern dispiro.rtv
cont (C21 H34 N2 S2)4
wave 0.80098
synchrotron
range 3.003 40
cell     21.7356 10.0565 9.4510  90.000   99.9602   90.000
space p 21/n

%alltrials

The use of the command %alltrials in the input file automatically 
activate the 'Explore trials' approach
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Global Optimization MethodsGlobal Optimization Methods

Global mimimum x*

Local mimimum

Local optimization methods Structure refinement

Global optimization methods Structure solution

F:ℝn→ℝFind x*= min{F(x)}, where 

X = fractional coordinates of (x,y,z)       or       

X = postion (x,y,z), orientation (θ, φ, ψ), torsion angles (τ
1
, τ

2
, … τ

n
) of molecular fragments
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Global optimization methodsGlobal optimization methods

Deterministic methods
Branch and Bound methods
Cutting Plane methods
Interval methods
…..................

Heuristic strategies
Genetic Algorithms (GA) 
Simulated Annealing (SA)
Tabu Search
Ant Colony Optimization
Particle Swarm Optimization (PS)
Bee Algorithms
Firefly Algorithms
Harmony Search
Big Bang-Big Crunch 
…...............................
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Global optimization methodsGlobal optimization methods

Deterministic methods
Branch and Bound methods
Cutting Plane methods
Interval methods
…..................

Heuristic strategies

(*) employed in solving crystal structure

Genetic Algorithms (GA) *
Simulated Annealing (SA)*
Tabu Search
Ant Colony Optimization
Particle Swarm Optimization (PS)*
Bee Algorithms
Firefly Algorithms
Harmony Search
Big Bang-Big Crunch *
…...............................
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Global optimization methodsGlobal optimization methods

Deterministic methods
Branch and Bound methods
Cutting Plane methods
Interval methods
…..................

Heuristic strategies

(*) employed in solving crystal structure

Genetic Algorithms (GA) *
Simulated Annealing (SA)*
Tabu Search
Ant Colony Optimization
Particle Swarm Optimization (PS)*
Bee Algorithms
Firefly Algorithms
Harmony Search
Big Bang-Big Crunch *
…...............................

Widely used and with 
the largest impact

 
Various modifications: 

parallel tempering (PT)
adaptive simulated annealing
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Global optimization methodsGlobal optimization methods

Genetic Algorithms (GA) *
Simulated Annealing (SA)*
Tabu Search
Ant Colony Optimization
Particle Swarm Optimization (PS)*
Bee Algorithms
Firefly Algorithms
Harmony Search
Big Bang-Big Crunch *
…...............................

Deterministic methods
Branch and Bound methods
Cutting Plane methods
Interval methods
…..................

Heuristic strategies

(*) employed in solving crystal structure

Widely used and with 
the largest impact

 
Various modifications: 

parallel tempering (PT)
adaptive simulated annealing
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Global optimization methodsGlobal optimization methods

Genetic Algorithms (GA) *
Simulated Annealing (SA)*
Tabu Search
Ant Colony Optimization
Particle Swarm Optimization (PS)*
Bee Algorithms
Firefly Algorithms
Harmony Search
Big Bang-Big Crunch *
…...............................

Deterministic methods
Branch and Bound methods
Cutting Plane methods
Interval methods
…..................

Heuristic strategies

(*) employed in solving crystal structure

Software **: DASH (SA), EXPO (SA), 
ENDEAVOUR (SA), FOX (PT), GEST (GA), 
PeckCryst (PS), PowderSolve (SA), PSSP (SA), 
TOPAS (SA), …       

commercial software are in red

(**) Cerny, R. & Favre-Nicolin, V. (2007). Z. Kristallogr. 222, 105–113. 

Widely used and with 
the largest impact

 
Various modifications: 

parallel tempering (PT)
adaptive simulated annealing
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Do not use chemical knowledge Can incorporate a massive amount of 
prior chemical information

ComparisonComparison
Traditional approaches Direct space methods

Clegg, W. & Teat, S. J., (2000). Acta Cryst. C56, 1343-1345.

Complexity of procedure depends on 
the number of degrees of freedom (DoF). 

High resolution is not needed.  
Default resolution: 2-2.5 Å.

Take time and patience. For large 
molecules: faster computer, run 
overnight, parallel program

Complexity of the problem depends 
on the number of non H-atoms in the 
a.u.

Take advantage by using data of 
higher resolution

Generally require less time to run

tetracycline (32 non-H atoms and 8 DoF) can 
be solved using global optimization
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Building starting modelBuilding starting model

Check for similar molecules in databases or in the literature

Optimize molecular geometry by computational chemistry 

programs
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Free Chemistry DatabasesFree Chemistry Databases

PubChem: https://pubchem.ncbi.nlm.nih.gov/

NIST Chemistry WebBook: http://webbook.nist.gov/chemistry/

Drugbank: http://www.drugbank.ca/

Other databases: ZINC, eMolecules, ChEBI, NMRShiftDB, ...

Chemical file formats: sdf, mol, mol2, 
cml, SMILES, ...

http://www.ba.ic.cnr.it/ochemdb/

http://journals.iucr.org/c/issues/2000/11/00/bm1422/index.html


  

A
IC

S
2

0
1

8
 –

 P
o

w
d

e
r 

D
iff

ra
ct

io
n

: T
h

e
o

ry
, S

o
ft

w
a

re
 a

n
d

 A
p

p
lic

a
tio

n
s.

 B
a

ri,
 2

9
 A

u
g

 –
 0

2
 S

e
p

Crystal Structure DatabasesCrystal Structure Databases**

CSD (Cambridge Structural Database) (organics & organometallics):

http://www.ccdc.cam.ac.uk/

ICSD (Inorganic Crystal Structure Database) 

(inorganics, elements, minerals & intermetallics): http://icsd.ill.fr/

COD (Crystallography Open Database) (general database): 

http://www.crystallography.net/

Other databases: ICDD PDF-4+, American Mineralogist Crystal Structure 
Database,  MINCRYST, Zeolite Structures Database, ... 

Non-commercial database are in red

File format: CIF (Crystallographic Information File)

*Joint special issue: Acta Cryst. B58, 317-422 (2002)
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Load crystal structures from COD

“File” menu →  “Import Fragment” menu →  “From COD”

“Modify” menu → “Add Fragments” menu → “From COD”

“View” menu →  “Jav Molecular Viewer”

https://pubchem.ncbi.nlm.nih.gov/
http://webbook.nist.gov/chemistry/
http://www.drugbank.ca/
http://www.ba.ic.cnr.it/ochemdb/
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Geometry optimizationGeometry optimization

Three levels of theory

Molecular-mechanics force fields (MM) 

Semi-empirical methods (SE)

Ab initio methods: Hartree–Fock methods, density 
functional theory (DFT)

Programs: MOPAC, Gamess, NWChem, Gaussian, ABINIT, 
Quantum ESPRESSO, ORCA, Molpro, Q-Chem, octopus, etc.

Strategy: MM → SI → DFT

http://icsd.ill.fr/
http://www.crystallography.net/
https://journals.iucr.org/b/issues/2002/03/01/
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obmodule.f90

The Use of Open BabelThe Use of Open Babel

EXPO2014 Open Babel

Fotran/C++ C++

Molecular-mechanics force fields (MMFF99 
and UFF provided by Open Babel library)

Able to process input and output files of 
common quantum-chemistry packages: 
GAMESS-US, NWChem, Gaussian, 
CRYSTAL, ABINIT, Quantum ESPRESSO 
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Graphical User Interface for MOPAC2016

Geometry optimization by MOPAC

MOPAC2016™ is a semiempirical quantum chemistry software package available FREE 
for academic, not-for-profit use. Download link: http://openmopac.net/downloads.html
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Molecule editorMolecule editor

Sketch molecules in 2D or 3D format 

Optimize the geometry by force field method 

Create input file for the quantum-chemistry calculations 

Read output files of the most common computational packages 

ACD/ChemSketch -  http://www.acdlabs.com 

Avogadro - http://avogadro.openmolecules.net/wiki/Main_Page

MarvinSketch -  http://www.chemaxon.com/products/marvin/

Gabedit: http://gabedit.sourceforge.net/

Some free available software

A molecule editor allows
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Building starting modelBuilding starting model

3D structure optimization

P 21/a

2-(4-Hydroxy-2-oxo-2,3-dihydro-1,3-benzothiazol-7-yl)
ethylammonium chloride N

frag
 = 2

N
dof

 = 6 + 3 + 2

Save as 
.mol, .mol2,
.fhz, .mop, 
.cif, .pdb, .frac

http://openmopac.net/downloads.html
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pBuilding starting model: example 2Building starting model: example 2

3D structure optimization

P2
1

N
frag

 = 2
N

dof
 = 6 + 6 + 4 + 4

 S-Ibuprofen
Two molecules in the a.u. (Z’=2)

Save as 
.mol, .mol2,
.fhz, .mop, 
.cif, .pdb, .frac

http://www.acdlabs.com/
http://avogadro.openmolecules.net/wiki/Main_Page
http://www.chemaxon.com/products/marvin/
http://gabedit.sourceforge.net/
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pBuilding starting model: example 3Building starting model: example 3

P 21/a

3D structure optimization

N
dof

 = 6 + 7

1,4-Bis(2-phenethyloxyethanesulfonyl)piperazine

center of symmetry a.u. is a half molecule
Z’ = 1/2

Structure solution
by DSM + DOC

N
dof

 = 6 + 14

15 times slower

Structure solution
by DSM

N
dof

 = 6 + 7
Recommended 

strategy
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famotidine form B

P 21/c

3D structure optimization

Building starting model: example 4Building starting model: example 4

N
frag

 = 1
N

dof
 = 6 + 6
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H atomsH atoms

H atoms do not contribute significantly to X-ray diffraction, they can be 
ignored during the structure solution

Eliminating the H atoms reduces the number of atoms and DoFs, 
decreasing the time to evaluate CF for each trial structure

Delete H atoms 
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Hydrogen calculationHydrogen calculation

Hydrogen atoms are positioned 
geometrically at X-ray distances

0.82 Å (X-ray) 

X-H (X-ray) < X-H (neutrons)

0.95 Å (neutrons) 
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Cost function

Starting temperature

Temperature reduction factor

Number of moves  

Number of SA runs

Resolution

Random seed

Simulated annealing optionsSimulated annealing options

● No. of molecular fragments
● No. of external DoFs
● No. of internal DoFs
● The flexibility of the molecule
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Cost Functions

Whole profile R factors: 

Integrated intensities R factors: 

Other cost functions: 
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By input file (*.exp)By input file (*.exp)

%Structure paracetamol
%Job Paracetamol  (C8H9NO2)
%Data
   Cell  7.100  9.380  11.708  90.0  97.42  90.0
   SpaceGroup p 21/n
   Pattern   paracetamol.xy
   Wavelength 1.54056
%fragment paracetamol.mol
%sannel

File > Load & Go

Command-line usageCommand-line usage
expo paracetamol.exp
or
expo paracetamol.exp –nogui
or
expo paracetamol.exp –auto  

Usage of comman %fragment
%fragment tetra AtC AtV [dist]
%fragment octa AtC AtV [dist]
%fragment square AtC AtV [dist]
%fragment cube AtC AtV [dist]
%fragment trigonal AtC AtV [dist]
%fragment prism_tetra AtC AtV [dist]
%fragment prism_trig AtC AtV [dist]
%fragment icosa AtC AtV [dist]
%fragment atoms chem_formula
%fragment smiles SMILES_string
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pUsing expo2014 for direct-space solutionUsing expo2014 for direct-space solution

File > Import Diffraction Pattern 

File > Import Structure

Solve > Simulated Annealing

By graphical interface

Modify > Add Fragments
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Molecular compoundsMolecular compounds

Paracetamol (form I polymorph) 
(C

8
H

9
NO

2
) *

*Nichols, C. & Frampton, C. S. (1998). J. Pharm. Sci. 87, 684–693.
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Non-molecular compoundsNon-molecular compounds

Crystal structure of Sb
2
(PO4)

3 
*

*Jouanneaux, A., Verbaere, A., Guyomard, D., Piffard, Y., Oyetola, S. & Fitch, A. N. (1991). Eur. J. Solid State Inorg. Chem. 28, 755-765.
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Non-molecular compoundsNon-molecular compounds

Sb2(PO4)3N
dof

 = 51

N
dof

 = 30

N
dof

 = 24

http://www.sciencedirect.com/science/article/pii/S002235491550590X?via%3Dihub
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Non-molecular compoundsNon-molecular compounds

Some atoms are expected to fall on special position

Different building blocks share some atoms

You cannot know the number and the type of the polyhedra
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Dynamical occupancy correction (DOC)Dynamical occupancy correction (DOC)

Falcioni, M. & Newsam, J. M. (1989). Nature 342, 260-262.

Favre-Nicolin, V. & Černỳ, R.  (2002). J. Appl. Cryst.. 35, 734-743

DOC is able to merge the excess atoms automatically

doc

or

doc atom1 atom2 ... 

doc Ni1
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pDynamical occupancy correction (DOC)Dynamical occupancy correction (DOC)

DOC slows down the computation time so it should be avoid DOC slows down the computation time so it should be avoid 
if no special positions or shared atoms are expected.if no special positions or shared atoms are expected.
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SA applied to non-molecular compoundsSA applied to non-molecular compounds

Sb2(PO4)3

Polyhedra rapresentation of Sb2(PO4)3  
by SA with DOC

SA with DOCSA with DOC
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pDelete duplicate atomsDelete duplicate atoms

29 atoms

2 atoms

2 atoms

2 atoms

17 atoms

*

symmetry equivalent atoms *

1.  Modify > Delete Duplicate Atoms
2. Tools > Build Bonds

2 atoms *
*

*
*

*

*

*
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Understanding processors

The difference between  a CPU and GPU

A modern quad-core CPU-Intel’s Core i7 © Intel
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Supercomputers Marconi by CINECA  (Italy)
244.800 cores in total

Notebooks Typically 2- 6 cores

Smartphones Typically 2- 10 cores

Workstations
Typically 4- 56 cores

Graphical Processing Units Up to 3000 cores

Parallel Machines
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pThree Programming models

Message Passing Interface (MPI)

Open MultiProcessing (OpenMP)

Compute Unified Device Architecture (CUDA)
Open Computing Language (OpenCL) 

Distributed-memory architecture

Shared-memory architecture

Coprocessor architecture 
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pThree Programming models

Message Passing Interface (MPI)

Open MultiProcessing (OpenMP)

Compute Unified Device Architecture (CUDA)
Open Computing Language (OpenCL) 

Distributed-memory architecture

Shared-memory architecture

Coprocessor architecture 
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Algorithm for structure 
solution by global 
optimization (GO)

N=N
r
?

Generate new seed 
for random number 
generator: seed

N

No

Yes

Input data, set N
r

N=0

N=N+1

GO

i=1,N
rp

Seed
i

Input data

N
r
 solutions

solution i

...

Network

Input data Input data

N
r
 solutions

Parallelization of structure solution by global optimization

Serial program Parallel program

PROC 0 PROC 1 PROC N
p

Send all solutions 
to PROC 0Number of runs of GO: N

r

Number of processors: N
p

Number of processors for run: N
rp
 = N

r
/N

p

GO

i=N
rp
+1,2N

rp

Seed
i

solution i

GO

i=N
rp
(N

p
-1)+1,N

r

Seed
i

solution i
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Running the Parallel Version of Expo2014

Computer with multi-core CPUs and Linux environment.

Open MPI installed.

Compiling Expo2014 from source and linking with MPI libraries

Run Expo2014 by using the launcher mpirun with the appropriate options.

mpirun -np 10 expo input_file.exp



  

DOF
Internal: 20
External: 6

Algorithm settings
NRUN: 100
NITER: 1000

Time
Single CPU-core: 500 h 
20 CPU-cores: 25 h
Parallel speedup: 20

Z-(Aib)
5
-O-t-Bu

Structure solution of small peptide

E. Benedetti, A. Bavoso, B. Di Blasio, V. Pavone, C. Pedone, M. Crisma, G. M. Bonora, and C. Toniolo, J. Am.Chem. 
Soc. 104, 2437 (1982)

Published

DSM

RMSD=0.0746 Å 
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Published

DSM

DOF = 6+53

RMSD=0.0746 Å 

%job beta-1,2,3-tris(heptadecanoyl)glycerol (beta-C17C17C17)
%structure glycerol17
%data
pattern av0044C17C17C17sup3.rtv
wave 0.850047
synch
space P-1
cell 11.86642 51.4495 5.43208 72.765 100.0950 120.577
%frag glycerol17_rand.mol
%sannel
nrun 100
bump

Structure of mono-acid β-triacylglycerols

Robert B. Helmholdt, René Peschar and Henk Schenk. Acta Cryst. (2002). B58,134±139
https://doi.org/10.1107/S0108768101016330
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DS with Low Quality Diffraction Pattern

Bond valence restraints Bond valence restraints 

Anti-bumping restraints Anti-bumping restraints 

Molecular geometry restraintsMolecular geometry restraints
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Bond Valence Restraints Bond Valence Restraints 

Atomic valence V
i
 of atom i in crystal structure is the sum of individual bond valences S

ij

distance between atoms i and j

bond valence parameters (bvparmyyyy.cif maintened by I.D. Brown and 
available from http://www.iucr.org/resources/data/datasets/bond-valence-parameters)

The estimated values V
i
 can be incorporated as restraints in the cost function (*): 

* J. Pannetier, J. Bassas-Alsina, J. Rodriguez-Carvajal & V. Caignaert, (1990). Nature 346, 343 - 345

global-instability index

https://doi.org/10.1107/S0108768101016330
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Check Bond Valence SumCheck Bond Valence Sum
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Imposing anti-bumping restraints Imposing anti-bumping restraints 

All nonbonded interactions between 
atoms that are separated by a path of 
bonds containing 4 rotable bonds or 
less are excluded

Only interaction between atom 1 and atom 5 is considered

https://www.nature.com/nature/journal/v346/n6282/abs/346343a0.html
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    = distance between two atoms A and B

= ideal distance

= permitted tolerance

= user supplied weight

Molecular Geometry RestraintsMolecular Geometry Restraints
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Non planar ring systems

Attention to non planar ring systems or unusual combinations 
of elements in functional groups
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Structure Solution of Diltiazem HydrochlorideStructure Solution of Diltiazem Hydrochloride

DS
DOF = 6+3+7

DS
DOF = 6+3+12 Published

DSM

RMSD=0.054 Å 

NO SOLUTION!

Geometry optimization by DFT
(NWchem, B3LYP/6-31G*)

*Kojic Prodic, B., Ruzic Toros, Z., Sunjic, V., Decorte, E. & Moimas, F. (1984). Helv. Chim. Acta, 67, 916–925.
https://doi.org/10.1002/hlca.19840670333
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%Structure diltia
%Job diltiazem HydrochlorideHydrochloride 
%Data
Cell   42.190  9.075  6.037  90  90  90
SpaceGroup p 21 21 21
Content    c 88 n 8 o 16 s 4 cl 4 h 108
Pattern    pd_0029.pow
Wavelength 1.54056
%fragment diltia_nw_noH_break.mol
%frag atoms Cl
%sannel
nrun 100
niter 5000
rest C3 C4
%save diltia.expo

Structure Solution of Diltiazem HydrochlorideStructure Solution of Diltiazem Hydrochloride
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Optimization of the molecular geometry to obtain accurate starting models

Restraints in the Rietveld refinement

H atoms

Refinement of crystal structure

Solve ambiguities 
(e.g., space groups, torsion angles)

Validation of experimental crystal structures

Combined powder X-ray diffraction data and Combined powder X-ray diffraction data and 
quantum-chemical calculationsquantum-chemical calculations

Two possible orientations of the pyridyl ring in the 
piroxicam molecule (Naelapää, K., van de Streek, J., 
Rantanen, J., and Bond, A. D. (2012), 
J.Pharm. Sci. 101, 4214–4219)

https://doi.org/10.1002/hlca.19840670333
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Assessing the solution with DFT-DAssessing the solution with DFT-D

Theoretical approach: plane wave (PW) density functional theory with 
dispersion correction (DFT-D)

RMSD for non H-atoms above 0.25 Å could indicate incorrect experimental 
crystal structure *

*Jacco ven de Streek et al. Validation of molecular crystal structures Acta Cryst. (2010). B66, 544–558

Experimental crystal structure

DFT-D3 with NWChem

Ibuprofen

RMSD=0.023 Å 
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Software Academic price (€) Link

VASP 4,000 www.vasp.at

CASTEP 1,800 www.castep.org

CRYSTAL 1,000 www.crystal.unito.it

Quantum ESPRESSO free www.quantum-espresso.org

NWChem free www.nwchem-sw.org

Abinit free www.abinit.org

Hardware: multi-core Linux Workstation

Time: approx. 100 hrs for small molecules on single CPU

DFT-D: HowtoDFT-D: Howto
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2-(4-Hydroxy-2-oxo-2,3-dihydro-1,3-benzothiazol-7-yl)
ethylammonium chloride

C
9
H

11
N

2
O

2
S·Cl

File > Import Diffraction Pattern

File > Import Structure

Refine > Rietveld 

From graphical interface:

Input file for Rietveld refinement:

%Structure ammonium
%Initialize
%Job ethylammonium chloride (C9H11N2O2SCl)
%Data

Cell 7.555 14.640 10.246 90 109.30 90
SpaceGroup p 21/a
Pattern    ammonium.xy
Wavelength 1.54056

%fragment ammonium_riet.cif
%rietveld

Structure refinement of CStructure refinement of C
99HH1111NN22OO22SS··ClCl
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Exercise 1 – structure determinationExercise 1 – structure determination of  of P(CP(C
66HH66))33  

Perform all the steps of the crystal structure 
determination of the Triphenylphosphine
Wavelength: 1.000972 (synchrotron radiation). 
Data file: Examples/pph3/pph3.xy

 P(C6H6)3

Compare the final model with the published model pph3_pub.cif 
in the folder Examples/pph3 (Tools → Overlay structures)

Tips 
File > Import Diffraction Pattern 
Pattern > Range (2-theta max = 60°)
Pattern > Indexing
Z = 4

http://jpharmsci.org/article/S0022-3549(15)31339-3/fulltext


  

A
IC

S
2

0
1

8
 –

 P
o

w
d

e
r 

D
iff

ra
ct

io
n

: T
h

e
o

ry
, S

o
ft

w
a

re
 a

n
d

 A
p

p
lic

a
tio

n
s.

 B
a

ri,
 2

9
 A

u
g

 –
 0

2
 S

e
p

Exercise 2 – structure determinationExercise 2 – structure determination of dapsone (C of dapsone (C
1212HH1212NN22OO22S)*S)*

Perform all the steps of the crystal structure 
determination of the dapsone loading the input 
file Examples/dapsone/dapsone.exp.

The structure model obtained at the end of Direct Methods procedure, 
executed on the first set of phases (default choice), is not interpretable. 
You have to try different phasing trials. The following steps automatically
carry out the structure solution process for each stored phasing trial and 
finally the best structure model is selected: 
● “Solve” → “Explore trials”
● “Select all new trial”
● “Go”
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pExercise 2 – structure determinationExercise 2 – structure determination of  of CC3636HH3030ClCl22NiPNiP22  

Load the input file Examples/nickel/nickel_dm.exp 
(File → Load & go), determine the space group and solve 
the structure by using the Direct Methods

If direct methods fail apply the RAMM technique or 
the alltrials procedure 

Save your best model in a nickel_part1.cif format

Part 1Part 1

Tip
correct space group is P 2/c 

http://www.vasp.at/
http://www.castep.org/
http://www.crystal.unito.it/
http://www.quantum-espresso.org/
http://www.nwchem-sw.org/
http://www.abinit.org/
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Solve the structure using the real space technique:

Use the polyhedra tool to visualize
the tetrahedral coordination of Ni

Part 2Part 2

Exercise 2 – structure determinationExercise 2 – structure determination of  of CC3636HH3030ClCl22NiPNiP22  

1.Load the input file Examples/nickel/nickel_ds.exp (File → Import)
2.Run Simulated Annealing (Execute)

Compare the best solution of SA (nickel_best1.cif)
with the nickel_part1.cif
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Contact, software download and info
http://www.ba.ic.cnr.it/softwareic/expo/

Download this lecture
http://www.ba.ic.cnr.it/softwareic/expo/tutorials-and-lectures/
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